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By Connie Miller 

You have all your customer addresses in a data file. Now what you want 

to do is get those addresses onto a set of mailing labels. Here's the best 

way to go about doing that, with some neat tips thrown in along the 

way. 

 

 

See all Answer Box columns 

See all Office columns 

A question from your comments 

I just want to print a set of mailing labels so that I can mail some information to 

my customers. I keep running into problems. Why is this so hard? 

Advice from the Answer Box 

You can watch my demos first, or start reading about the finer details of this 

process. 

The number of labels that you want to create determines how complicated it is to 

create them. 

 
 

It's pretty easy to: 

� Print one label or a set of labels all addressed exactly the same way. To learn 

how, click a link in the See Also box.  

Applies to

Microsoft Office Word 2003 

Microsoft Word 2002
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Set up the label main document

Connect the label main document to a data file 

Add placeholders and information that stays the same

Preview the labels
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� Type a few different labels on one label sheet and print them. To do this, you 

have a couple of different options: 

� Consider downloading one of the label templates from the Templates on 

Microsoft Office Online Web site.  

� Use the Envelopes and Labels dialog box to create a page of labels. 

1. On the Tools menu, point to Letters and Mailings, and then 

click Envelopes and Labels.  

2. Click the Labels tab, and then click Options.  

3. Choose the type of printer and the supplier of the label sheets that 

you'll print your labels on. Under Product Number, select the 

number that corresponds to the number listed on your package of 

label sheets, and then click OK.  

4. In the Envelopes and Labels dialog box, click New Document. 

A new label document opens. 

5. Type the information on the labels that you want to use.  

6. On the File menu, click Print to print the labels.  

When you want to create and print more than one sheet of labels, things can get 

a little gnarly. Creating more than one sheet of labels involves using a mail-merge 

process. After you get the process down, it isn't all that difficult — but it is a 

process. And, at each step in the process, you face potential pitfalls. 

In this column, we're going to dissect the mail-merge label process and go 

through it step by detailed step. As part of each step, we'll look at the potential 

pitfalls and discuss how to avoid or recover from them. 

The mail merge label process 

Creating a set of labels involves five major steps: 

1. First, you set up the label main document. The label main document is the 

page of labels that you start with. It's the model for the size and shape of 

all the labels that you eventually print.  

2. Then, you connect the label main document that you just set up to a data 

file that contains the names and addresses you want to add to the labels. 

More about data files later.  

3. Next, you add placeholders (officially called fields) to the label main 

document for the information (such as names and addresses) that will be 

different on each label. At this step, you also add any information, such as 

a return address or a logo or other picture, that will be the same on every 

label.  

4. Then, you preview the labels to make sure that information from the data 

file merged correctly. When you're happy with the results, you complete 

the merge.  

5. Finally, you print the labels.  

Step 1: Set up the label main document 

 

Watch the demo 

 

Next demo 

You knew you were going to be creating labels, so you've probably already been 

to the office supply store. You bought a package of label sheets from one of the 

label sheet suppliers, such as Avery, AOne, or Formtec. Each sheet is a certain 

size and contains a certain number of labels with specific dimensions. 

To set up the label main document, you need to match the dimensions of that 

document with the dimensions of the labels on the sheets that you brought home 

from the office supply store. 

Here's how you set up the label main document: 

1. Start Word.  

2. On the Tools menu, point to Letters and Mailings, and then click Mail 

Merge to open the Mail Merge task pane.  

3. In the task pane, under Select document type, click Labels. Under 

Step 1 of 6 at the bottom of the task pane, click Next: Starting 

document.  
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4. To set up a new label main document, click Change document layout. 

Why Change document layout? When you open Word, a blank 

document opens by default. That default document does not have a label 

layout. If you're going to create labels, you need to change the layout of 

that default document to a label layout. 

5. Under Change document layout in the task pane, click Label options.  

6. In the Label Options dialog box, you have several choices to make: 

 

 The type of printer that you're using to print labels. 

The supplier that produced your label sheets.  

The number that corresponds to the product number listed on your 

package of label sheets.  

Note  What if the product number for the label sheets that you bought 

doesn't match any of the choices in the Label Options dialog box? You 

can still print your labels; you just have to do some customizing. First, 

carefully measure the labels on the sheet you have and take note of the 

measurements and how many labels fit on a single sheet. Next, follow the 

process described in Create custom-sized labels, beginning with step 4. 

7. When you've made all your label choices, click OK. 

A label document opens with the insertion point blinking away in the first 

label, and you're ready for the next step. 

Note  If what you see on the screen just looks like a regular document 

instead of labels, you may have the option for hiding gridlines turned on. 

On the Table menu, click Show Gridlines to show lines that indicate the 

label boundaries. 

8. Under Step 2 of 6 at the bottom of the task pane, click Next: Select 

recipients.  

Step 2: Connect to the data file 

 

Watch the demo 

 

Next demo 

If you're creating mailing labels, you must be planning a mailing. If you're 

planning a mailing, you probably have a mailing list somewhere that contains the 

names and addresses of customers, employees, or other intended recipients. This 

mailing list is what we mean by "data file." The purpose of this step in the 

process is to connect to that mailing list data file so that you can get the names 

and addresses from your list onto your labels. 

Note  If you don't already have a mailing list data file set up, keep reading. You 

can set one up from within Word, as you'll see. 

Word can connect to a lot of different types of data files (to see a complete list, 

click a link in the See Also box), so the mailing list that you have will most likely 

work just fine. For example, you might have your recipient names and addresses 

in a Microsoft Excel worksheet, a Microsoft Access database table, or a table that 
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you set up in Word. Or maybe you keep your Microsoft Outlook® Contacts file up 

to date especially for this purpose. Any of those options (and many others) will 

work just fine. 

To learn a lot more about data files and how to use them in a mail merge, click a 

link in the See Also box. 

Notes 

� Check to see how recipient names are set up in the mailing list data file. 

Merging names from the data file onto your labels will work best if you have 

first names and last names in two different columns.  

� Postal codes that start with a zero won't merge correctly from an Excel 

worksheet unless you type an apostrophe before the initial zero. The 

apostrophe won't show up in the worksheet cell or on your label; it just 

makes the zero behave.  

To establish a connection between your label mail document and your 

data file 

In the Mail Merge task pane, under Select recipients, you have three options: 

� Use an existing list  Click this option if you already have a data file, such as 

an Excel spreadsheet, Access database table, or Word table, that contains 

your recipients' names and addresses.  

� Select from Outlook Contacts  Click this option if you want to use names 

and addresses from your Outlook Contacts list.  

� Type a new list  Click this option if you don't have a data file yet that 

contains recipients' names and addresses.  

Click one of the following options to find out what to do next. 

Use an existing list 

1. Under Use an existing list, click Browse to locate your mailing list data 

file.  

2. In the Select Data Source dialog box, locate the file, select it, and then 

click Open.  

3. If you see the Select Table dialog box, click the table or worksheet that 

contains your recipient names and addresses.  

4. The Mail Merge Recipients dialog box opens.  

Select from Outlook Contacts 

Type a new list 

The Mail Merge Recipients dialog box gives you the opportunity to filter or sort 

the entries in the data file. For example, you might want to do a mailing only to 

customers in a certain postal code or city. Or, you might want to create labels for 

a mailing to employees who joined the company within the past year. 

If you want to create labels for all the recipients in your data file and you don't 

need to do any sorting or filtering, just click OK to move on. 

If you don't want to print labels for all the recipients in your data file, you can do 

some or all of these things before you click OK: 

� To eliminate one recipient, click the check box at the beginning of the 

recipient's row to clear it.  

� To sort the rows according to the ascending or descending order of 

information in a particular column (for example, if you want to create the 

labels in alphabetical order by last name), click the column heading.  

� To filter the list according to specific criteria (for example, all the people who 

live in a certain postal code), click the arrow next to a column heading. When 

you click the arrow, you see a list that looks similar to this one: 

 
 

 Click (All) if you previously filtered the list and now want to include all the 
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entries again. 

Click the value by which you want to filter the list. In this example, the 

Postal Code column contains only two unique codes. In the case of your data 

file, the list of unique entries would most likely be much longer.  

Click (Blanks) to filter the list to only those entries in this column that are 

blank.  

Click (Nonblanks) to filter the list to only those entries in this column that 

have content.  

Click (Advanced) to open the Filter and Sort dialog box, where you can 

narrow according to more complex criteria. For example, you can narrow the 

list to three postal codes or two cities.  

Note  Any filtering and sorting changes that you make in the Mail Merge 

Recipients dialog box don't affect the original data file. 

After you close the Mail Merge Recipients dialog box, you'll see «Next Record» 

fields on all the labels in your starting document. Don't delete them. They won't 

show up on your printed labels and they're important in the next step of the 

process. Under Step 3 of 6 at the bottom of the task pane, click Next: Arrange 

your labels to move to the next step. 

Step 3: Add placeholders and information that stays the same 

 

Watch the demo 

 

Next demo 

At this step in the process, you add content to the label main document. This 

content includes: 

� Information that will be the same on each label   For example, you 

might want a company logo on each label. You can just type or place this 

information right on the label main document.  

� Information, such as the recipient address, that is unique to each 

label   You can't type information unique to each label on one label main 

document. Instead, you add placeholders, or fields, to the label main 

document. These fields correspond to categories (columns) in your mailing 

address data file. When you complete the mail merge in the next step of the 

process, information from each row in the data file replaces the fields to 

create a set of unique labels.  

Here's how a label main document might look with a picture and a field on it: 

 
 

Click one of the following options to find out what to do next. 

Add a picture 

Add placeholder fields 

Step 4: Preview the merged labels and complete the merge 

(This information is covered in the next demo.) 

Next demo 

When you click Next: Preview your labels at the bottom of the Mail Merge 

task pane, information from the data file replaces the placeholder fields on the 

labels. You'll be able to see right away if the addresses are being displayed 

properly. You can also click the double-arrow buttons in the task pane to page 

through the labels, or you can click Find a recipient to locate a specific label. 
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Note  As you page through the labels to preview them, what happens on the 

screen can be a little disorienting. Let's say that you're starting from the first label 

in the upper-left corner of the page. When you click the right double-arrow 

button, you move across the page horizontally until you reach the label at the 

right edge of the page. Then you move down a row to the label at the left edge 

of the page, and so on. On the screen, though, the label that you're currently 

previewing always ends up looking like it's at the top-left corner of the page. This 

is just a previewing convenience. The labels haven't actually shifted around on 

the page or anything spooky like that. 

Some things that might need fixing 

� Missing address elements  If you don't see all the elements of an address, 

you might need to match a column heading from your data file with an 

element from the address block. Click the Previous link at the bottom of the 

Mail Merge task pane. Right-click the «Address Block» field in the first label, 

and then click Edit Address Block on the shortcut menu. In the Insert 

Address Block dialog box, click Match Fields. In the Match Fields dialog 

box, be sure that each element you're using from the list on the left has a 

matching column heading on the right. If (not matched) appears opposite 

any important elements, click the arrow in the box that says (not matched), 

and then click the correct column name in the list that appears. Click OK, and 

then click OK again.  

� Unintended recipients  If labels have been created for some recipients 

whom you don't want to include in this mailing, click Edit recipient list in 

the Mail Merge task pane to open the Mail Merge Recipients dialog box, 

and then filter the list of recipients.  

� Missing recipients  If only a subset of the records (rows) in your data file 

merged onto the labels, click Edit recipient list in the Mail Merge task 

pane to open the Mail Merge Recipients dialog box. Make sure that you 

haven't inadvertently filtered the list of recipients. Click the arrow in the 

column heading for each category that you don't want to filter, and then click 

(All) in the list. If you haven't filtered the list of recipients in any way, check 

your data file to be sure that it is organized correctly.  

� Most of the labels are blank  If you only see one label with an address in 

it and the rest of the labels are blank, you probably forgot one little step 

when you were arranging content on your label main document. At the 

bottom of the Mail Merge task pane, click Previous: Arrange your labels. 

In the task pane, under Replicate labels, click Update all labels to copy 

the fields that you added to the first label onto all the other labels on the 

sheet. Then click Next: Preview your labels to return to the preview step.  

When you're satisfied with the way your labels look, click Next: Complete the 

merge at the bottom of the Mail Merge task pane. 

Step 5: Print the labels 

 

Watch the demo 

 

At the Complete the merge step in the process, you're ready to print your 

labels. You have two choices. You can: 
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� Click Print in the Mail Merge task pane to print the labels. 

Do this if you are satisfied with the previews and ready to print the final 

labels. 

� Click Edit individual labels in the Mail Merge task pane to create a new 

document with all the merged labels in it. 

Do this if you want to review the labels more thoroughly before you print the 

final labels, or if you want to make custom changes to specific labels. When 

you're satisfied with the labels, you can print them right from this document. 

Print the labels 

Create a new label document and then print the labels 

Some problems you might encounter when you print 

� Fields are printed instead of information  If you see fields in your 

printed labels (such as «Address Block») rather than values for those fields, 

you might need to change a setting. On the Tools menu, click Options. On 

the Print tab, make sure that the Field Codes check box under Include 

with document is cleared.  

� Printed results don't match the preview  If the printed result doesn't 

match what you saw in the preview, most likely you are using an outdated or 

damaged printer driver. You can download the latest printer drivers from your 

printer manufacturer's Web site.  

Before you close the label main document 

You've just gone to all the trouble to set up a label main document and connect it 

to a mailing list data file. By saving the label main document, you can preserve 

the effort that you've put in and make it easier and faster to create a set of labels 

the next time you need one. When you save a label main document, you save the 

document's connection to the data file. 

The next time you open the document, you'll see a message that information 

from a data file will be placed in the document. Click Yes to continue. If you used 

an Outlook Contacts list as your data file, you'll also see the Select Contact List 

dialog box. Select the Contacts list folder that you connected to originally, and 

then click OK. On the Tools menu, point to Letters and Mailings, and then 

click Mail Merge. The Mail Merge task pane opens at the Select recipients 

step, where you can choose the data file that you want to connect to. 

� If you want to use the same data file without any filtering or sorting, just click 

Next: Arrange your labels, and continue through the mail-merge process.  

� If you want to filter or sort the list of recipients from the data file to create a 

new set of labels, click Edit recipient list.  

� If you want to merge recipient information from a different data file, click 

Select a different list.  

Wishing you much happy labelling, 

Connie, the Answer Box monitor 

About the author  

Connie Miller, a writer on the Microsoft Office User Assistance team, collects and 

responds to issues that come to the attention of the Word Answer Box. To submit 

a detailed question of your own that we may be able to respond to, send 

feedback. 
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